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Netop Remote Control on other operating systems 

The current guide explains how to install Netop Remote Control on a number of 
operating systems other than Microsoft Windows.  

Generally Remote Control features and functions work the same way regardless 
of operating system and are described in the User’s Guide and in the help file. 
However, for some features there are slight variations; these variations are 

described under the relevant operating system. 

In addition to a section on Netop Host Manager, the current guide deals with 

Netop Remote control under the following operating systems: Linux, Mac, 
Solaris, OS2 and DOS. 

1 Netop Remote Control for Linux 

Netop Remote Control for Linux includes a Netop Guest and a Netop Host. 

Netop Guest for Linux can connect to a remote Netop Host by using the TCP/IP 
(TCP) and WebConnect communication protocols.   

Netop Host for Linux enables a remote Netop Guest to connect by using the 

TCP/IP, TCP/IP (TCP), serial (modem), HTTP and WebConnect communication 
protocols. The sections below include information about  

 Installation 

 Netop Guest  

 Netop Host 

1.1 Install on Linux 

Before you install, please verify that your computer meets the technical 

requirements: see the Tech Specs page on www.netop.com on this path Netop 
Home > Products > Administration > Netop Remote Control > Tech 

Specs >Linux. 

Notes 

 Before installing Netop Guest or Netop Host, you must remove any previous 
versions of the guest and the host programs. 

 To be able to install, the user logged on to the computer must have system 
user privileges. 

You can install Netop Remote Control for the supported Linux versions from the 
files on the netop.com download page (Netop Home > Support > Downloads 

> Netop Remote Control).  

The download page will include separate installation or archive files for the Netop 

Guest and Netop Host depending on your Linux distribution. The archive files will 
typically contain both the installation files and a Perl script allowing you to install 
both modules at the same time. 

Netop Guest and Netop Host can be installed by double-clicking the relevant 
installation file within your desktop environment. 

http://www.netop.com/
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To install via a terminal window, change the path to locate your extracted Netop 
files and execute the following Perl script: 

perl install.pl 

This command will start the interactive installation script. 

Select to install Netop Guest, Netop Host or both. 

If both are selected, Netop Guest for Linux will be installed first and Netop Host 
for Linux will be installed next.  

As part of the installation process, you must accept the End User License 
Agreement (EULA) and specify the license number.  

When the license number has been approved for the Netop Host, the Netop Host 
will load and initialize. 

By default, the Netop Host will use both TCP and UDP communication on port 

6502. 

Uninstall on Linux 

Netop Guest: 

To uninstall the Netop Guest, either use the RPM Package Manager or execute 
the following commands in a terminal window: 

rpm -e NetopGuest 

rm -rf /etc/NetopGuest 

When using the RPM Package Manager to uninstall the Guest, the above 

command should also be executed to remove the /etc/NetopGuest folder and its 
contents. 

Netop Host: 

To uninstall the Netop Host, either use the RPM Package Manager or execute the 
following commands in a terminal window: 

rpm -e NetopHost 

rm -rf /etc/NetopHost 

When using the RPM Package Manager to uninstall the Host, the above 

command should also be executed to remove the /etc/NetopHost folder and its 
contents. 

1.2 Netop Guest on Linux 

Netop Guest for Linux is an application that can be used to connect to a remote 
computer that is running the Netop Host. Once connected to the Host, the Guest 

will be able to view the screen and control the keyboard and mouse on the 
target machine, initiate two-way file transfer and interact with the local user. 

This section includes these topics: 
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 Load and unload Netop Guest for Linux 

 Netop Guest functionality on Linux 

 

Load and Unload Netop Guest on Linux 

To load Netop Guest for Linux, in a terminal window execute this command: 

netopguest 

After entering the license key, the Netop Guest application will be launched: 

 

/ 

The netopguest command assumes that the netopguest program file resides in 

the /usr/bin directory or is in a directory included in the global PATH. If 
netopguest resides in another directory, precede the command by the full 

directory path. 

The user who loads Netop Guest for the first time must have the privileges to 

create a LICENSE file in the /etc/NetopGuest directory. For example: 

su - -c netopguest 

To unload Netop Guest, click Exit on the File menu. 

Netop Guest Functionality on Linux 

Netop Guest for Linux has a similar look and feel as the Windows Guest but the 

functionality in Netop Guest for Linux is reduced. Menus and commands that are 
not available on Linux are shown in gray text and with gray icons. 

Netop Guest for Linux can connect to a remote Netop Host by using the TCP/IP, 

TCP/IP (TCP) and WebConnect communication protocols. 
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To connect to another port number than the Netop default port 6502, add the 

port number to the Host name or address after a colon, for example: 
192.168.100.1:1234. 

Help is available from the Help menu: click the Contents command to show this 
window: 

 

The help includes all content from the Netop Guest for Windows, also features 
that are unavailable on Linux. 

Note that in addition to TCP/IP (TCP), the protocol called WebConnect is also 
available. When WebConnect is selected, the Edit and Browse buttons become 
available. Click Edit to open a new window used for configuring WebConnect 

credentials (similar to the Windows version); click Browse to view all active 
Hosts for the configured WebConnect domain. 

1.3 Netop Host on Linux 

Netop Host for Linux is an application that enables a remote Netop Guest to 

connect in order to access resources on the Netop Host computer. 

Netop Host includes these programs: 

 Netop Host Daemon (netophostd) 

Netop Host Daemon on Linux will typically run when the computer operating 

system starts. A user with system user privileges can start and stop Netop 
Host Daemon. 

 Netop Host Program (netophost) 

Netop Host Program on Linux will load and typically start when Netop Host 

Daemon on Linux loads. If started, communication will be initialized enabling 
a Netop Guest to connect. A user can typically control the Netop Host 
Program from the Netop Host GUI. 

 Netop Host GUI (netophostgui) 

Netop Host GUI on Linux shows the Netop Host graphical user interface. It 

will not load automatically when the Netop Host Program loads. A user can 
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load and unload the Netop Host GUI but only a user with system privileges 
can make changes to the Netop Host program options. 

Start and Stop Netop Host Daemon on Linux 

Netop Host Daemon will start and stop with the Linux operating system. A user 

with system user privileges can start, stop, restart and report the status of the 
Netop Host Daemon with these terminal window commands: 

 

Function Command Description 

start 
/etc/init.d/netophostd start 

This command will start 
Netop Host Daemon on 

Linux and load Netop Host 
Program on Linux. 

restart 
/etc/init.d/netophostd restart 

This command will restart 
Netop Host Daemon on 

Linux and load Netop Host 
Program on Linux 

status 
/etc/init.d/netophostd status 

This command will return a 

message of whether Netop 
Host Daemon on Linux is 
running or not. 

stop 
/etc/init.d/netophostd stop 

This command will unload 

Netop Host Program on 
Linux and stop Netop Host 

Daemon on Linux. 

Display and hide the Netop Host Window on Linux 

The Netop Host GUI will not load automatically when the Netop Host Program 

loads. 

If the Netop Host Program on Linux is loaded, execute this command in a 
terminal window: 

netophostgui 
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This will display the Netop Host interface: 

 

Note: The NetopHostGUI command assumes that the Netop Host GUI program 

file resides in the /usr/bin directory or is in a directory included in the global 
PATH. If the Netop Host GUI resides in another directory, precede the command 

by the full directory path. 

To unload the Netop Host GUI, click Exit on the File menu. 

Netop Host Functionality on Linux 

The Netop Host for Linux window contains most of the Netop Host for Windows 

window elements, but has reduced functionality compared to the Windows 
version and setup is organized differently. 

Netop Host for Linux enables a remote Netop Guest to connect by using the 

TCP/IP, TCP/IP (TCP), Serial (modem), HTTP and WebConnect communication 
protocols. Once authenticated, the Netop Guest can view the remote screen, 

control the keyboard and mouse, transfer files between the computers and 
interact with the local user. 

Unlike Netop Guest for Linux, no help system is available from the Netop Host 

for Linux window. 

Functions that match Netop Host for Windows functions are explained in the 

User’s Guide Host dialog boxes section. 
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To change the setup options of the Netop Host, click the Options button on the 
toolbar or click Options on the Tools menu: 

 
 

User name Type a valid Linux logon name 

To change the setup options of the Netop Host, the user 

must have the privileges to edit the /etc/NetopHost/host.xml 
file. 

Password Type the matching Linux logon password. 

Click OK to show this window: 
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2 Netop Remote Control for Mac 

Netop Remote Control for Mac includes a Netop Guest and a Netop Host. 

Netop Guest for Mac can connect to a remote Netop Host by using the TCP/IP 

(TCP) and WebConnect communication protocols.   

Netop Host for Mac enables a remote Netop Guest to connect by the TCP/IP, 
TCP/IP (TCP), HTTP and WebConnect communication protocols. The sections 

below include information about  

 Installation 

 Netop Guest  

 Netop Host 

2.1 Install on Mac 

Before you install, please verify that your computer meets the technical 
requirements: see the Tech Specs page on www.netop.com on this path Netop 

Home > Products > Administration > Netop Remote Control > Tech 
Specs >Mac. 

Notes 

 Before installing Netop Guest or Netop Host, you must remove any previous 

versions of the Guest and the Host programs. 

 To be able to install, the user logged on to the computer must have 

administrator user privileges. 

You can install Netop Remote Control for the supported Mac versions from the 

files on the netop.com download page (Netop Home > Support > Downloads 
> Netop Remote Control).  

Open the relevant .DMG file downloaded from the Netop website and double-
click on the resulting .PKG file to show the installation wizard that will guide you 
through the Netop installation. Accept the license agreement and specify the 

licensee name and Netop license number when prompted. When the Netop Host 
license number has been approved, the Host for Mac will load, initialize and be 

available for communication with a Netop Guest. 

Uninstall on Mac 

In the Applications/NetopHost directory, run the netophostuninstall.pkg file to 
show the Uninstall Netop Host window that will guide you through the 
uninstallation. 

Uninstalling a Netop installation requires that the user logged on to the 

computer has administrator rights. 

2.2 Netop Guest on Mac 

Netop Guest for Mac is an application that can be used to connect to a remote 
computer that is running the Netop Host. Once connected to the Host, the Guest 

http://www.netop.com/
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will be able to view the screen and control the keyboard and mouse on the 
target machine, initiate two-way file transfer and interact with the local user. 

This section includes these topics: 

 Load and unload Netop Guest for Mac 

 Netop Guest functionality on Mac 

Load and Unload Netop Guest on Mac 

Start Netop Guest from the Applications folder: 

/ 

To stop Netop Guest, click the close symbol. 

Netop Guest Functionality on Mac 

Netop Guest for Mac has a similar look and feel as the Windows Guest but the 

functionality in Netop Guest for Mac is reduced. Menus and commands that are 
not available on Mac are shown in gray text and with gray icons. 

Netop Guest for Mac can connect to a remote Netop Host by using the Internet 

TCP/IP (TCP) and WebConnect communication protocols. 

To connect by another port number than the Netop default port 6502, add the 

port number to the Host name or address after a colon, for example: 

192.168.100.1:1234. 

Note that in addition to TCP, the protocol called WebConnect is also available. 

When WebConnect is selected, the Edit and Browse buttons become available. 
Click Edit to open a new window used for configuring WebConnect credentials 

(similar to the Windows version); click Browse to view all active Hosts for the 
configured WebConnect domain. 
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2.3 Netop Host on Mac 

Netop Host for Mac is a server type application that enables a remote Netop 
Guest client type application to connect to access resources on the Netop Host 
for Mac computer. 

Netop Host includes these programs: 

 Netop Host Program for Mac 

Netop Host Program for Mac will load and initialize when the computer 
operating system starts. When started, communication will be initialized 

enabling a Netop Guest to connect. Netop Host GUI for Mac 

Netop Host GUI for Mac shows the Netop Host for Mac window. It will not 

start to show the Netop Host for Mac window when Netop Host Program for 
Mac loads.  

A user can start and stop Netop Host GUI for Mac to display and hide the 

Netop Host Window. 
 

Display and Hide the Netop Host Window 

Netop Host GUI for Mac will not start when Netop Host Program for Mac loads. 

If Netop Host Program on Mac is loaded, select 
Applications/NetopHost/NetopHostGUI to show this window: 

 

To unload Netop Host GUI for Mac to hide the Netop Host on Mac window, quit 

the NetopHostGUI application. 

Netop Host Functionality on Mac 

The Netop Host for Mac window contains most of the Netop Host for Windows 

window elements, but Netop Host for Mac has limited functionality as compared 
to the Windows version and setup is organized differently. 
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Netop Host for Mac enables a remote Netop Guest to connect by the TCP/IP, 
TCP/IP (TCP), HTTP and WebConnect communication protocols to remote control 

the Netop Host for Mac computer, transfer files between the computers and run 
a typed text chat session between the computer users. 

No help system is available from the Netop Host for Mac window. Functionalities 
that match Netop Host for Windows functionalities are explained in the User’s 
Guide. 

To change the setup of Netop Host 
Program for Mac, click the Netop 

Host for Mac toolbar Options button 
or click Options on the Tools menu 
to show this window: 

 

 

User name Type a valid Mac logon name 

To change the setup of Netop Host Program for Mac, the 

user must have the privileges to edit the 
/etc/NetopHost/host.xml file. 

Password Type the matching logon password. 

Click OK to show this window: 

 

See the Netop Host Manager section in this document for information about the 
application. 
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3 Netop Host Manager 

Netop Host Manager is used to manage the configuration settings for Netop Host 

The Netop Host Manager window has three panes: 

 An upper left selection pane where you can select the element to set up. 

 An upper right attributes pane where you can edit the attributes of the 
element in the selection pane. 

 A lower message pane that can show messages from Netop Host Manager. 

To ensure that changes have been applied, restart Netop Host after setup 

changes. 
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3.1 Selection Pane 

This is the Netop Host Manager window selection pane: 

 

It contains a branch structure of Netop Host setup elements. The attributes of a 
selected setup element will be shown in the attributes pane. 

The Local configuration branch expands into these branches: 

 HostComputer 

 Addresslists 

 Guest users. 

HostComputer branch 

 

In the following tables, the default value is marked with an asterisk (*) 

HostComputer > General > Startup 

Attribute Value 

Start at boot Enabled*/Disabled 
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If the attribute is set to Enabled, communication will start when Netop Host 
Program loads to enable the Netop Guest to connect. If set to Disabled, 

communication will not start when the Netop Host Program loads. 

The Netop Host computer user can typically Start, Stop and Restart 

communication from the Netop Host window toolbar buttons. 

HostComputer > Communication > Network listen 

 
 

Right-click (Mac: Ctrl+click) Network listen and point to New to show the 
communication profiles you can create: 

 WebConnect 

 HTTP 
 Tcp 

 Udp 
 Serial (Linux only) 
 

WebConnect - <Name> attributes: 

Attribute Value 

WebConnect Service 
Password 

<String of characters> The field will show dots or 
asterisks. 

WebConnect password associated with the 
WebConnect username. 

Enable Disabled/Enabled* 

Choose whether the profile should be enabled or 
disabled. 

WebConnect Service URL <String of characters> URL location of the 
Connection Manager required to use WebConnect. 

WebConnect Service 

Domain 

<String of characters> WebConnect Domain 

associated with the WebConnect username. 

WebConnect Service 
Username 

<String of characters> Account name used to 
access the WebConnect service 

Name <String of characters> The name of the 

communication profile as it appears in the Host 
Manager tree structure. 
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HTTP - <Name> attributes: 

Attribute Value 

Sendport <Send port number> (80*) 

Configure outbound port number. 

Receiveport <Receive port number> (80*) 

Configure inbound port number.  

Enable Enabled/Disabled* 

Choose whether the profile should be enabled or 
disabled. 

UseHTTP Enabled*/Disabled 

Enable or disable HTTP encapsulation. Disabling this 
option will enable TCP. 

Name <String of characters>  

The name of the communication profile as it 

appears in the Host Manager tree structure.  

 

TCP - <Name> attributes: 

Attribute Value 

Enable Enabled*/Disabled 

Name <String of characters> (<Random characters>*) 

Receive Port <Receive port number> (6502*) 

Send Port <Send port number> (6502*) 

Use HTTP Enabled/Disabled* 

A TCP setup element will be identified by the Name attribute value. Initially, a 
“TCP – TCP” setup element with default other attribute values will be available. 

You can create multiple TCP setup elements.  

Each TCP setup element will make a communication profile that uses the TCP/IP 

(TCP) communication device available to Netop Host. If the Enable attribute 
value is “Enabled”, the communication profile will be enabled if Netop Host 
communication is enabled. 

The Use HTTP attribute will encapsulate data packets in HTTP making it easier to 
traverse firewalls.  
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UDP - <Name> attributes: 

Attribute Value 

Enable Enabled*/Disabled 

Name <String of characters> (<Random characters>*) 

Receive Port <Receive port number> (6502*) 

Send Port <Send port number> (6502*) 

Maximum Transmission 

Unit (MTU) 

<Number of bytes> (2600*) 

Use Netop Name Server Enabled*/Disabled 

Primary Name Server <Netop Name Server DNS name or IP address> 
(nns1.netop.com*) 

Secondary Name Server <Netop Name Server DNS name or IP address> 
(nns2.netop.com*) 

Ignore port information 

from Name Server 

Enabled/Disabled* 

Override port information 
from Name Server with 

port 

<Port number> (6502*) 

A UDP setup element will be identified by the Name attribute value. Initially, a 
“TCP – TCP/IP” setup element with default other attribute values will be 

available. 

You can create multiple UDP setup elements.  

Each TCP setup element will make a communication profile that uses the TCP/IP 

(TCP) communication device available to Netop Host. If the Enable attribute 
value is “Enabled”, the communication profile will be enabled if Netop Host 

communication is enabled. 

Right-click (Mac: Ctrl+click) a UDP setup element, point to New and click 
Broadcastlist to create in a new branch below the UDP setup element: 

Broadcast List - <Name> attribute: 

Attribute Value 

Broadcastlist name <Address List setup element Name attribute value> 

(<Random characters>*) 

A Broadcastlist setup element will be identified by the Broadcastlist name 
attribute value. Initially, a “Broadcastlist – My list” setup element will be 

available. 

You can create multiple Broadcastlist setup elements.  
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Each Broadcastlist setup element will make an IP broadcast list available to the 
UDP setup element. 

You can delete the UDP setup element or only the Broadcast list. If you delete 
the UDP setup element, any Broadcast list setup elements below will be deleted 

automatically. 

 

Serial is available only on a computer that runs on a Linux operating system.  

Serial - <Name> attributes: 

Attribute Value 

Enable Enabled/Disabled* 

Name <String of characters> (<Random characters>*) 

Null Modem Disabled* 

Definition <Modem setup element Name attribute value> 
(<Random characters>*) 

Serial Port <Serial port name> (COM 1*) 

Data Rate <Bits per second> (38400*) 

Flow Control RTS/CTS*/None/Modem’s preferred 

Dial Type Tone*/Pulse 

Wait before call back <Seconds> (10*) 

A Serial setup element will be identified by the Name attribute value. Initially, a 

“Serial - My modem” setup element will be available.  

You can create multiple Serial setup elements.  

Each Serial setup element will make a communication profile that uses the Serial 
communication device available to Netop Host If the Enable attribute value is 
“Enabled”, the communication profile will be enabled if Netop Host 

communication is enabled.  

This Netop Host for Linux version does not support Null Modem and call back. 

Modem Definitions Branch 

 

In the following tables, the default value is marked with an asterisk (*) 

Right-click the Modem definitions, point to New and then click Modem to 
create a new branch below the Modem Definitions branch. 

New > Modem: This command will be enabled only on a computer that runs on a 
Linux operating system.  
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Modem - <Name> attributes: 

Attribute Value 

Name <String of characters> (<Random characters>*) 

Dial <Dial modem command string> (ATD?D*) 

Hang-up <Hang up modem command string> (ATH0S0=0*) 

Setup1 <Setup1 modem command string> (AT&F*) 

Setup2 <Setup2 modem command string> 

(AT&C1&D2S10=20*) 

Send <Send modem command string> (<No value>*) 

Answer <Answer modem command string> (ATS0=1*) 

Max Data Rate <Bits per second> (38400*) 

RTS/CTS Enabled*/Disabled 

Ignore Carrier Signal Enabled/Disabled* 

A Modem setup element will be identified by the Name attribute value. Initially, 
a “Modem – Hayes” setup element with default other attribute values will be 

available. 

You can create multiple Modem setup elements.  

Each Modem setup element will make a modem configuration available to Netop 

Host. 

Import > Modem: This command will be enabled only on a computer that runs 

on a Linux operating system.  

Select this command to show the Choose a file to open window that will show 
xml files in the /etc/NetopHost directory. Select modems.xml to show this 

window: 
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The modems.xml file contains Netop created modem configurations named by 
modem trade names. Select a modem name and click OK to create a Modem 

setup element with the attribute values of the imported modem configuration. 

modems.xml is the Netop Host version of the Netop Host (Windows) modem 

database. 

HostComputer > Hostname > Netop Name Server 

Attribute Value 

Name Space ID <String of characters> (PUBLIC*) 

The Name Space ID attribute value identified a private section of a Netop Name 

Server name database. Netop modules must specify the same Name Space ID 
attribute value to connect by Netop Name Management. 

 

HostComputer > Hostname > Naming 

Attribute Value 

Naming Mode Computer name*/Enter or leave blank 

Host Name <String of characters> (<No value>*) 

Computer name will identify Netop Host by its computer name (generally 

recommended). Enter or leave blank will identify Netop Host by the Host Name 
attribute value. 

 

HostComputer > Host security > Maintenance 

Attribute Value 

Old password <String of characters> (<No value>*) The field will 

show dots or asterisks. 

Password <String of characters> (<No value>*) The field will 
show dots or asterisks. 
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Attribute Value 

Guest access security Enabled*/Disabled 

All other configuration Enabled*/Disabled 

Program exit and “Stop 
Host” 

Enabled*/Disabled 

If the Password attribute has a value, maintenance password protection will be 

enabled. If enabled, Netop Host or Netop Host Manager will request the 
Password attribute value to execute a maintenance password protected action 

including changing the Password attribute value. To change the maintenance 
password, specify the current maintenance password as the Old Password 
attribute value and the new maintenance password as the Password attribute 

value. Maintenance password is explained in the Remote Control User's Guide. 

Address Lists Branch 

 

 

In the following tables, the default value is marked with an asterisk (*) 

Right-click (Mac: Ctrl+click) the Addresslists branch, point to New and the click 
Address to create in a new branch below the Address Lists branch: 

Address List - <Name> attribute: 

Attribute Value 

Name <String of characters> (<Random characters>*) 

An Address List setup element will be identified by the Name attribute value. 

Initially, an “Address List - My list” setup element will be available. 

You can create multiple Address List setup elements.  

Each Address List setup element will be available to other Netop Host Manager 

setup elements. 

You can also create a new branch below an existing Address setup element: 

Address - <Name> attributes: 

Attribute Value 

Name <String of characters> (<Random characters>*) 

Type IP address*/MAC address/DNS address 

An Address setup element will be identified by the Name attribute value. 

Initially, an Address - <Random characters> setup element will be available.  

You can create multiple Address setup elements.  



21 

 

Each Address setup element will be an element in the Address List setup element 
above. The Value attribute value format must satisfy the Type attribute value 

format requirements. For example, if the Type=IP address, the format of the 
value field must be an IP address only. 

You can delete an Address setup element or an entire Address List setup 
element. If you delete an Address List setup element, the elements below it will 
also be deleted. 

Guest Users Branch 

 

In the following tables, the default value is marked with an asterisk (*) 

Guest Security attribute: 

Attribute Value 

Mode System authentication*/Netop 
authentication/Security Server authentication 

Select a Mode attribute value to make Netop Host apply it to all connecting 
Netop Guests. 

The Guest Security setup element expands into these elements: 

 Security Server Authentication: Netop Host will request Netop Guest ID 
credentials from a connecting Netop Guest to request individual 

authentication and Role Assignment by Netop Security Management to apply 
the returned role to Netop Guest.  

This branch element expands into this setup element: 

Security Server attribute: 

Attribute Value 

Security Server Group ID <32-digit hexadecimal number> 
(2D5D8022082B5E58E579E373805EB699*) 

The default Security Server Group ID attribute value is the Netop default 
value. You can copy the Group ID from the Security Server Group Name 
window. 

 Roles: Right-click (Mac: Ctrl+click) Roles, point to New and then click Role 
to create a Role setup element in a new branch below the Roles branch 

element. 

Role - <Name> attributes: 
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Attribute Value 

Name <String of characters> (<Random characters>*) 

Remote Control (View) Enabled*/Disabled 

Use Keyboard and Mouse Enabled*/Disabled 

Blank Screen Enabled*/Disabled (not available) 

Lock Keyboard and 
Mouse 

Enabled*/Disabled (not available) 

Transfer Clipboard Enabled*/Disabled (not available) 

Boot Enabled*/Disabled 

Chat Enabled*/Disabled 

Audio Chat Enabled*/Disabled (not available) 

Send Files to Host Enabled*/Disabled 

Receive Files from Host Enabled*/Disabled 

Run Programs Enabled*/Disabled (not available) 

Redirect Print Enabled*/Disabled (not available) 

Confirm Access Never*/Always/Only when logged in 

A Role setup element will be identified by the Name attribute value. Initially, a 

“Role - Full Access” setup element with default other attribute values will be 
available.  

You can create multiple Role setup elements.  

Each Role setup element will make a security role available to Netop Host. 

System Authentication: Netop Host will request a user name and password 

from a connecting Netop Guest to authenticate each Netop Guest individually by 
Netop Host computer operating system logon credentials. If the Netop Guest 

specified user name matches a User setup element Name attribute value, Netop 
Host will apply the User setup element Role attribute value specified role. Right-
click (Mac: Ctrl+click) this branch element and select the New > User command 

to create a User setup element in a new branch below the System Authentication 
branch element: 

User - <Name> attributes: 

Attribute Value 

Name <String of characters> (<Random characters>*) 
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Attribute Value 

Role <Role setup element Name attribute value> (Full 
Access*) 

A User setup element will be identified by the Name attribute value. 

Initially, a User - root setup element with the Role attribute value Full 
Access will be available.  

You can create multiple User setup elements.  

Delete: Select this command to delete the selected User setup element. 

Netop Authentication: If no Password attribute value is specified, Netop 

Host will apply the Role attribute value specified role to all connecting 
Netop Guests. If a Password attribute value is specified, Netop Host will 

request it from all connecting Netop Guests to apply the Role attribute 
value specified role to them.  

This setup element has these attributes: 

Attribute Value 

Password <String of characters> (<No value>*) 

Role <Role setup element Name attribute value> (Full 
Access*) 

3.2 Attributes Pane 

The attributes pane contains setup element attributes. Double-click or right-click 
an attribute record to show an Edit <Type> Attribute window: 

 

The elements that you can edit depend on the type of the attribute value. These 

are the possible types: 

 Boolean (check box) 

 String (text field) 

 Numeric (number only field) 
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 Enumerate (drop-down box) 

The OK button will be enabled if the attribute value has been changed into a 

valid value. 

3.3 Message Pane 

The Netop Host Manager message pane is the area beneath the selection pane 
and the attributes pane.  

Before you click OK to apply setup changes, make sure that you have seen any 
messages displayed here. 

  



25 

 

4 Netop Remote Control for Solaris 

Netop Remote Control for Solaris includes Netop Guest for Solaris and Netop 
Host for Solaris. 

Netop Guest for Solaris can connect to a remote Netop Host by the TCP/IP and 
TCP/IP (TCP) communication protocols to control the Netop Host computer and 
transfer files between the computers. 

Netop Host for Solaris enables a remote Netop Guest to connect by the TCP/IP 
and TCP/IP (TCP) communication protocols to control the Netop Host for Solaris 

computer, transfer files between the computers and run a typed text chat 
session between the computer users. 

The sections below include information about  

 Installation 

 Netop Guest 

 Netop Host 

4.1 Install on Solaris 

Before you install, please verify that your computer meets the technical 
requirements: see the Tech Specs page on www.netop.com on this path Netop 
Home > Products > Administration > Netop Remote Control > Tech Specs 

>Solaris. 

To be able to install, the user logged on to the computer must have system user 

privileges. 

You can install Netop Remote Control for Solaris from these files: 

 NetopGuest-<Version number>-<Build number>.SunOS.tar.gz 

 NetopHost-<Version number>-<Build number>.SunOS.tar.gz 

In a terminal window, execute these commands: 

su - 

This command will install with system user privileges. 

cd /cdrom/NRC/SOLARIS  

This command will specify the file location on the Netop Remote Control CD. 

perl install.pl 

This command will start the interactive installation script. 

Select to install Netop Guest for Solaris, Netop Host for Solaris, or both. 

If both are selected, Netop Guest for Solaris will be installed first and Netop Host 
for Solaris will be installed next.  

As part of the installation process, you must specify the Netop Host for Solaris 
license number. If you are installing a trial version, the trial includes the license 

number and you do not have to type anything. 

http://www.netop.com/
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When the license number has been approved, Netop Host for Solaris will load 
and start to enable communication 

Uninstall  

Netop Guest: 

In a terminal window, execute these commands: 

rm -f /usr/bin/NetopGuest 

rm -f /usr/bin/dtlspy 

rm -rf /etc/NetopGuest 

Netop Host: 

In a terminal window, execute these commands: 

perl /etc/NetopHost/cfg/uninstall.pl 

rm -rf /etc/NetopHost 

4.2 Netop Guest for Solaris 

Netop Guest for Solaris is a client type application that can connect to a remote 
Netop Host to access resources on the Netop Host computer. 

This section includes these sections: 

 Load and Unload Netop Guest for Solaris 

 Netop Guest Functionality for Solaris 
 

Load and Unload Netop Guest  

To load Netop Guest for Solaris, in a terminal window execute this command: 

NetopGuest 

- to show this window on the graphical screen: 
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The NetopGuest command assumes that the NetopGuest program file resides in 

the /usr/bin directory. If NetopGuest resides in another directory, precede the 
command by the full directory path. 

When Netop Guest for Solaris is loaded for the first time, the user will be asked 

to specify the Netop Guest license number. 

If you are installing a trial version, the trial includes the license number and you 
do not have to type anything. 

 

The user that loads Netop Guest for Solaris for the first time must have the 

privileges to create a LICENSE file in the /etc/NetopGuest directory. 

When Netop Guest for Solaris shows the Netop Guest for Solaris window, it can 
connect to a remote Netop Host. 

To unload Netop Guest, click Exit on the File menu. 

Netop Guest Functionality 

Netop Guest for Solaris has the same menus, tabs and commands Netop Guest 
for Windows but the functionality in Netop Guest for Solaris is reduced. Menus 
and commands that are not available for Linux are shown in gray text and with 

gray icons. 

Netop Guest for Solaris can connect to a remote Netop Host by the TCP/IP and 

TCP/IP (TCP) communication protocols to control the Netop Host computer and 
transfer files between the computers. 
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To connect by another port number than the Netop default 6502, add the port 

number to the Host name or address after a colon, for example: 
192.168.100.1:1234. 

Help is available from the Help menu: click the Contents command to show this 
Window: 

 
The help includes all content from the Netop Guest for Windows, also features 
that are unavailable on Solaris. 

4.3 Netop Host for Solaris 

Netop Host for Solaris is a server type application that enables a remote Netop 
Guest to connect to access resources on the Netop Host for Solaris computer. 

Netop Host includes these programs: 

 Netop Host Daemon for Solaris 

Netop Host Daemon for Solaris will typically run when the computer operating 
system runs. A user with system user privileges can start and stop Netop 

Host Daemon. 

 Netop Host Program for Solaris 

Netop Host Program for Solaris will load and typically start when Netop Host 
Daemon for Solaris loads. If started, communication will be enabled to enable 

Netop Guest to connect. A user can typically control Netop Host Program for 
Solaris from the Netop Host for Solaris window. 

 Netop Host GUI for Solaris 

Netop Host GUI for Solaris shows the Netop Host for Solaris window. It will 
not load to show the Netop Host for Solaris window when Netop Host 
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Program for Solaris loads. A user can load and unload Netop Host GUI for 
Solaris to display and hide the Netop Host Window. 

Start and Stop Netop Host Daemon 

Netop Host Daemon for Solaris will start and stop with the computer operating 

system. A user with system user privileges can start, check and stop Netop Host 
Daemon for Solaris with these terminal window commands: 

/etc/init.d/NetopHostd start 

This command will start Netop Host Daemon for Solaris and load Netop Host 
Program for Solaris. 

/etc/init.d/NetopHostd status 

This command will return a message of whether Netop Host Daemon for Solaris 
is running or not. 

/etc/init.d/NetopHostd stop 

This command will unload Netop Host Program for Solaris and stop Netop Host 
Daemon for Solaris. 

Display and Hide the Netop Host Window 

Netop Host GUI for Solaris will not load when Netop Host Program for Solaris 

loads. 

If Netop Host Program for Solaris is loaded, execute this command in a terminal 
window: 

NetopHostGUI 
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- to show this Netop Host for Solaris window on the graphical screen: 

 

Note: The NetopHostGUI command assumes that the Netop Host GUI for Linux 

program file resides in the /usr/bin directory. If Netop Host GUI for Linux resides 
in another directory, precede the command by the full directory path. 

To unload Netop Host GUI for Linux, click Exit on the File menu. 

Netop Host Functionality 

The Netop Host for Solaris window contains most of the Netop Host for Windows 
window elements, but Netop Host for Solaris has limited functionality as 

compared to the Windows version and setup is organized differently. 

Netop Host for Solaris enables a remote Netop Guest to connect by the TCP/IP 
and TCP/IP (TCP) communication protocols to control the Netop Host for Solaris 

computer, transfer files between the computers and run a typed text chat 
session between the computer users. 

Unlike Netop Guest for Solaris, no help system is available from the Netop Host 
for Solaris window. 

Functionalities that match Netop Host for Windows functionalities are explained 

in the User’s Guide Host dialog boxes section. 

To change the setup of Netop Host Program for Linux, click the Netop Host for 

Linux window toolbar Options button or click Options on the Tools menu to 
show this window: 
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User name Type a valid Solaris logon name 

To change the setup of Netop Host Program for Solaris, the 

user must have the privileges to edit the 
/etc/NetopHost/NetopHost.xml file. 

Password Type the matching Solaris logon password. 

Click OK to show this window: 

 

The window components are explained in the Netop Host Manager section of the 

present document. 
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5 Netop Remote Control for OS/2 

Netop Remote Control for OS/2) includes Netop Host for OS/2 which is a slightly 
modified Netop for OS/2 version 6.5 Netop Host. 

Netop Host for OS/2 enables a remote Netop Guest to connect to remote control 
the Netop Host for OS/2 computer, transfer files between the computers and run 
a typed text chat session between the computer users. The Netop Host for OS/2 

computer user can request help from a Netop Guest that offers help services. 

The TCP/IP, TCP/IP (TCP), IPX, NetBIOS, ISDN (CAPI), Serial and APPC 

communication protocols are available. 

The sections below include information about  

 Installation 

 Netop Host 

5.1 Install on OS/2 

Before you install, please verify that your computer meets the technical 
requirements: see the Tech Specs page on www.netop.com on this path Netop 

Home > Products > Administration > Netop Remote Control > Tech 
Specs >OS/2. 

To be able to install, the user logged on to the computer has administrator 

rights. 

The OS2.txt file contains Netop Remote Control for OS/2 installation and startup 
instructions.  

Run (double-click) the SETUP.EXE file to show the Select Install Components 
window. Specify the destination directory. Specify the licensee name and Netop 

Host license number. 

If you are installing a trial version, the trial includes the license number and you 
do not have to type anything. 

Select startup options to start installation. When installation has completed, you 
will typically be prompted to reboot the computer to load and start Netop Host 

for OS/2 to enable communication. 

Uninstall (OS/2) 

To uninstall Netop Host for OS/2, delete the directory in which it is installed and 
remove any matching CONFIG.SYS file statements. 

5.2 Netop Host for OS/2 

After a typical installation, Netop Host for OS/2 will load and start when OS/2 
starts to show this window: 

http://www.netop.com/
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If this window is shown in front of the Host window: 

 

- Click the Communication Profiles button on the Host window toolbar to show 

the Communication Profile Setup window. Select the communication profiles you 
want to enable. Click the Start button on the Host toolbar to actually enable the 

selected communication profiles. 

When the Host window title bar shows “Running”, a remote Netop Guest can 
connect to Netop Host for OS/2. 

If Netop Host for OS/2 is not loaded, you can load it in different ways: 

 From a desktop folder or icon 

A typical Netop Host for OS/2 installation will create a Netop desktop folder 
that will contain the NHOST2.EXE file typically as an icon: 

 

Double-click this icon to load Netop Host for OS/2. 

 From a folder 

Double-click the NHOST2.EXE file in the directory in which Netop Host (OS/2) is 

installed to load Netop Host for OS/2. 

 From a command line 

In a command window, specify this command: 

<Netop directory path>nhost2 

- To load Netop Host for OS/2. 
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You can add these switches to the nhost2 command (leave a space before each 
switch): 

Switch Function 

-C:<Communication profile> 
Enable <Communication profile> in 
addition to other enabled 
communication profiles. 

-L[:<Number>] 
Enable selected communication profiles, 
optionally with a delay of <Number> 

seconds. 

-R 
Unload Netop Host. 

-R:<Host ID> 
Replace the current Host ID by <Host 
ID>. 

-GA+, -GA- 
-GA+: Notify a connecting Netop Guest 
of the MAC/IP address of the currently 
connected Netop Guest (default action). 

-GA-: Do not notify a connecting Netop 
Guest of the MAC/IP address of the 

currently connected Netop Guest. 

-FRAMES:<Number> 
Grab <Number> Host screen image 

sections at a time to transfer the Host 
image to the Guest (default: 20). 

-SLEEP:<Number> 
Wait <Number> milliseconds between 
each grabbing of frames (default: 10) 

-STEALTH 
Hide the Host window when Netop Host 

loads. 

Examples 

NHOST2 -L 

Explanation: Load Netop Host and start it enabling selected communication 

profiles. 

NHOST2 -L:20 -R:JOHN 

Explanation: Load Netop Host and start it enabling selected communication 
profiles with a 20 seconds delay replacing the current Host ID by JOHN. 
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Win-OS/2 Full Screen Support 

Netop Host for OS/2 supports remote control of the full screen Windows 3.1 user 

interface if NHOST2W.EXE is loaded. 

A typical Netop Host for OS/2 installation will add this C:\CONFIG.SYS 

statement: 

DEVICE=C:\NETOP\NHOST2W.SYS 

You can load NHOST2W.EXE manually or add it to the RUN= line in your Win-

OS/2 WIN.INI file, for example: 

RUN=<Netop directory path>\NHOST2W.EXE 

These options will automatically load NHOST2W.EXE when you start the program 

manager in a full screen Win-OS/2 session. 

Netop Host Functionality 

The Netop Host for OS/2 window contains most of the Netop Host for Windows 
window elements, but Netop Host for OS/2 has limited functionality as compared 

to the Windows version 

Netop Host for OS/2 enables a remote Netop Guest to connect to remote control 
the Netop Host for OS/2 computer, transfer files between the computers and run 

a typed text chat session between the computer users. The Netop Host for OS/2 
user can request help from a Netop Guest that offers help services. 

The TCP/IP, TCP/IP (TCP), IPX, NetBIOS, ISDN (CAPI), Serial and APPC 
communication protocols are available. 

Select the Help menu Help Index command to show this window: 

 

Netop Host for OS/2 includes a context-sensitive help system that explains 
available Netop Host for OS/2 functionalities.  
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Netop Host for OS/2 functionality is quite similar to Netop Host for Windows 

functionality, so you may also find the Netop Remote Control User's Guide 
helpful.  
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6 Netop Remote Control for DOS 

Netop Remote Control for DOS includes Netop Host for DOS which is the RemPC 
module of Netop for DOS (Network) version 4.32.  

Netop Host for DOS enables a remote Netop Guest to connect by the RemPCIPX 
v. 4.3 or RemPCNB v. 4.3 communication device to remote control the Netop 
Host for DOS computer and run a typed text chat session between the computer 

users. 

The sections below include information about  

 Installation 

 Netop Host  

6.1 Install on DOS 

To install Netop Host for DOS, copy these files to your computer: 

 REMPC.BAT: Default Netop Host program file that will detect available 

communication and load Netop Host accordingly. 

 REMPCIPX.COM: IPX Netop Host program file. 

 REMPCNB.COM: NetBIOS Netop Host program file. 

 REMPCTST.COM: Communication detection program file used by REMPC.BAT. 

6.2 Netop Host for DOS 

Before loading Netop Host for DOS, set up computer network communication by 
IPX and/or NetBIOS. 

To load Netop Host for DOS manually, execute this command: 

<Installed directory path>rempc <Host name> 

The command is not case sensitive. 

This will run REMPC.BAT to detect available network communication and load 
Netop Host for DOS accordingly using the <Host name> name.  

REMPC.BAT will select IPX if available, otherwise NetBIOS if available.  

To use only IPX, replace rempc by rempcipx.  

To use only NetBIOS, replace rempc by rempcnb. 

If Netop Host for DOS loads, the computer will return a confirmation and a 
command prompt: 

[DOS_Successfully_Loaded.bmp] 

If Netop Host for DOS cannot load, the computer will return an error message. 
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You can set up the computer to load Netop Host for DOS at computer start by 
adding the load command to the AUTOEXEC.BAT file. 

When Netop Host for DOS is loaded, a remote Netop Guest can connect to it. 

When Netop Host for DOS is unconnected, the computer screen upper right 

corner will show a green rectangle with a flashing white asterisk. When Netop 
Host for DOS is connected, a red/white flashing rectangle with a + will be 
shown. 

You can extend the load command by these parameters (insert one space before 
each parameter): 

Parameter Function 

#<Password> 
Requests <Password> from connecting Guests. Each 
connecting Guest has three password attempts. If exceeded, 
the Host will reject further connection attempts until reloaded. 

*<Group name> 
If using NetBIOS, a Guest can connect only if its Guest ID is 
<Group name>. 

/B:<Number> 
<Number> specifies the number of buffer blocks of 516 bytes in 
the range 1 to 40 (default: 4). The number of buffer blocks may 
affect transfer speed. 

/C 
Enables typed text chat in the RemPC Chat Mode window. 
When connected, the Host computer user can start a chat 
session by pressing CTRL+ALT+C. 

/G 
Enables remote control of 800 x 600 pixels 16 colors Super 
VGA mode Host computer applications. 

/K:<Number> 
<Number> specifies keyboard and mouse control: 

0: No keyboard and mouse control. 

1: Advanced keyboard 1 control (default selection). 

2: Advanced keyboard 2 control. 

3: Standard keyboard control. 

If Guest computer keystrokes come out wrong on the Host 
computer screen, specifying another valid <Number> value may 
solve the problem. 

/L 
Enables the Guest to lock the Host computer keyboard and 
mouse. 

/M 
Enables remote control of a DOS mouse. 
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Parameter Function 

/Q 
Enables the Host computer user to confirm access. The Host 
computer will beep when a Guest connects. To allow access, 
press CTRL+ALT+A. To deny access, press any other key. 

/S:<Number> 
<Number> specifies the Host stack size in the range 100 to 
10240 Bytes (default: 200). The stack size may affect remote 
control of Host applications. 

/U 
Enables public Host name for the Host to respond to broadcast 
communication. 

To show available load command parameters on the screen, execute this 
command: 

<Installed directory path>rempc /? 

To unload Netop Host for DOS, execute this command: 

<Installed directory path>rempc /R 

 


